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WELCOME 

Welcome to the Amlib DIY/SIP2 5.3 Module Installation Guide for the Amlib DIY (Self-Service) Module. 

This is a major release updating the DIY/SIP2 module. The complete installation time is estimated at 

less than one (1) hour to complete.  

BEFORE YOU BEGIN THE INSTALLATION… 

Read the Installation Notes First 

Please carefully read the entire installation guide prior to commencing the actual DIY/SIP2 release 

installation.  

If you have any questions please contact: support-amlib@oclc.org. 

Please Note: This installation process is for existing Amlib customers who have purchased the 

optional DIY (Self-Service) Module. 

WARNING: Please make sure that the latest version of the Amlib Client is installed and operational 

on the Self Issues workstation BEFORE installing the Amlib DIY (Self-Service) Module. 

Serial Numbers Required for Installation of Amlib Modules 

The Amlib DIY/SIP2 5.3 Module installation requires a serial number. If you did not receive a serial 

key for the modules that your library has purchased you should contact OCLC (UK) Limited before 

commencing the upgrade.  

file:///C:/Users/prenticj/Documents/Source/Documents/Support/Installation%20Guides/Amlib%205.3/support-amlib@oclc.org
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AMLIB Supported Operating System Requirements 

PC Client 

Hardware  Amlib support recommend Pentium 4 CPU and above for best 

performance 

Operating System  Windows XP, 2000, Vista, Windows 7 

Memory (RAM)  Minimum 256 Mb for Windows XP 

 Minimum 256 Mb for Windows 2000 

 Minimum 1GB for Windows 7   

 Minimum 1GB for Windows Vista 

Hard Disk  150 Mb Free Disk Space (if installed on local HDD) 

Display  SVGA (800x600) minimum 

RDBMS / ODBC 

Driver Software 

 Relevant Microsoft SQL Server ODBC Driver installed (minimum MDAC 

2.6 and above) 

 Oracle Net8 (SQL * Net) is required 

Interface and 

Security System 

Link 

 SIP2 Compatible via TCP/IP or Serial Port 

 Certified vendors: 

o 3M 

o Raeco 

o Talking Technologies 

o Queensland Library Supplies 

o STi LogiTrack RFID 

o EnvisionWare    

o Smart Library 

Please Note: To assist with email support we highly recommend that the default installation folders 

suggested in the following notes be retained.  

For example: 

 Amlib Client software: C:\Amlib (or D:\Amlib, E:\Amlib) 
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DIY SELF ISSUES & SIP2 GATEWAY PRODUCT OVERVIEW 

The Amlib DIY (Self-Service) Module can be configured as: 

 Patron Self Serve application (either on kiosks or PC’s) 

 “Middleware” Application Gateway providing a SIP2 gateway to the Amlib database for 

other systems such as TalkingTech iTiva telephone renewal, 3M Self Check, STi LogiTrack 

RFID, EnvisionWare and SmartLibrary 

Amlib DIY Module as “Middleware” Gateway 

For libraries that have installed Self Serve systems and software 

from other vendors, the Amlib DIY Module acts as “middleware” 

application gateway between their Vendor’s Self Serve system 

and the Amlib database. In this environment the Amlib DIY 

Module can be installed as a background application, and in 

most cases using the standard SIP2 protocol (SIP2 is a standard 

interface / protocol for integrating library management 

circulation functions with 3rd party vendors). 

As of July 2011 the vendor systems that the Amlib DIY Module has certified integration with are: 

 3M Self Check 

 Raeco Fast Track 

 EnvisionWare 

 QLS      

 STi LogiTrack RFID   

 SmartLibrary 

 TalkingTech iTiva Telephone Renewal 

Amlib DIY Module as Self Service Application 

 The Amlib DIY Module can be installed on a purpose built Public Self Serve Kiosk featuring a 

Windows-based PC, barcode scanner and receipt printer. One of the compatible vendors who can 

provide a purpose built Self Serve Kiosk is Queensland Library Supplies (QLS) which also provides a 

security deactivation device. 

The Amlib DIY Module is a “user friendly” 

application, operating in an OPAC style environment 

where borrowers can easily issue and return their 

items in a secure environment whilst preventing 

access to Amlib modules. The Amlib DIY Module 

enables borrowers to “Self Issue” items by placing 

their borrower card then item barcode(s) under the 

scanner. On completion, the borrower can choose to 

print a receipt. The Amlib DIY Module displays 
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current borrower loans as well as borrower and item alerts (for example: money owing, item not 

available for loan) and can prevent loan of specific item types based on system parameters. For 

libraries using the QLS Self Serve Kiosk, Amlib will automatically send a security deactivation code for 

the item. 

Touch Screens can be used to minimise keyboard use at the DIY workstation. 

A self-returns function is also available, so Borrowers can return items currently on loan. 

Examples of Amlib DIY Deployed in Libraries: 

 Public libraries and educational institutions using Amlib DIY on Self Serve Kiosks with 

facilities for printing receipts and security deactivation. 

 Special and corporate libraries simply using Amlib DIY on a secure networked PC in their 

library – this is ideal when all the borrowers are organisational staff with 24-hour access to a 

library that is not always staffed 

 School libraries with library monitors (often students) issuing and returning items using 

Amlib DIY within a secure environment prevented from accessing the standard Amlib 

Circulation management functions 
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INSTALL AMLIB CLIENT ON DIY WORKSTATION  

The Amlib Client needs to be installed on the DIY Workstation, and connectivity to the database 

confirmed PRIOR to the installation of the Amlib DIY Module. 

PLEASE NOTE: If the Amlib Client is already installed on the workstation you can skip this section 

and proceed to Install Amlib DIY (Self-Service) Module. 

IMPORTANT: Please ensure that you have full read/write access to the \Amlib folder on your DIY 

workstation (for example: C:\Amlib) and that you are logged in with Administrative Privileges. 

1. The Amlib 5.3 Client installer is available on the OCLC Website, under Setup Programs>Amlib 

Client: 
https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-3/setup-programs.en.html 

(contact Amlib support if you require a login to this website) 

2. Download the Amlib53Setup.exe and save it on your DIY workstation 

3. Double-click the Amlib53Setup.exe to launch the installation Wizard – the Setup – Amlib 

Client screen will open displaying the Welcome message: 

 

4. Click the Next button 

  

https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-3/setup-programs.en.html
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5. The Serial screen will display, prompting you for valid Serial Number: 

 

6. Enter the Serial Key supplied by OCLC (UK) Limited (case sensitive!) and then click the Next 

button – the Installation Location screen will display: 

 

7. Select the folder where the Amlib Client is to be installed – a Default location will 

automatically display – for example: C:\Amlib 

Please Note: If you do not wish to use the Default location, click the Browse button to 

manually setup the location for the \Amlib folder 

8. Click the Next button 
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9. The Select Components screen will display: 

 

10. Choose which components should be installed: 

a. Modules To Install: 

 Amlib Staff User (Full) – upgrades Amlib Staff Client (catalogue, circulation, 

etc.) 

 Amlib Opac Only – only upgrades the Amlib Client Server OPAC module (only 

select this option if you installing on a Public Access workstation) 

b. Report Template Paper Format: 

 A4 (Australia, UK, Europe) – installs the Amlib report templates formatted 

for A4 paper type 

 Letter (USA, Canada) – Installs Amlib report templates formatted for Letter 

paper type 

c. Admin Tasks: 

 Modify Amlib Database (dba) Login Configuration – only select this option if 

you wish to change the hidden Database Login and Password to internally 

connect to the Amlib database (if the RDBMS does not have user 

SYSADM/SYSADM) 

11. Select options and click the Next button 
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12. The Database Relational Management System screen will display prompting for the RDBMS 

to be used: 

 

13. Select from the following options: 

 Microsoft SQL Server 

 Oracle 

14. If your library is using Microsoft SQL Server for Amlib: 

d. Select Microsoft SQL Server and click the Next Button – the Configure the SQL ini file 

screen will display: 
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e. Enter the following information: 

 Enter the SQL database server name – default display is current machine 

name 

 Enter the database server IP Address – the default display is the current 

machine IP address 

 Enter the SQL Server ODBC driver name – this is normally SQL Server, so 

there is no need to change that 

f. Click the Next button 

15. If your library is using Oracle for Amlib, select Oracle and click the Next Button 

16. If you selected Modify Amlib Database (dba) Login Configuration on the Select Components 

screen at Step 7 the RDBMS Login to be used with Amlib screen will display: 

 

a. You will be prompted for a hidden Amlib Database (DBA) Login to connect the Amlib 

SQL database: 

 AmlibNet DBA User 

 AmlibNet DBA Password 

b. Please Note:  

 This will be the RDBMS Login that Amlib will use as a *HIDDEN* Amlib 

Database (DBA) Login to connect the Amlib Client to the Amlib database 

 An encrypted User and Password can be entered (generated using the Amlib 

nopasswd.exe utility) 

 This will be stored in within the Windows\amlib.ini configuration file 

c. To accept the defaults, click the Next button (this will be most customers) 
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17. The Select Start Menu Folder screen will display: 

 

18. Enter a Start menu folder name (or leave as Amlib Library Management System)  and click 

the Next button – the Select Additional Tasks screen will display: 

 

19. You can unselect the Install desktop icons for selected components if you DO NOT wish to 

install the Amlib icon on the desktop 
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20. Click the Next button – the Ready to Install screen will display with a summary of the 

installation tasks to be performed: 

 

21. Click the Install button – the Installing window will display: 
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22. When complete click the Finish button 

 

23. The setup Wizard will close 

Installation of the Amlib 5.3 Client is now complete. 
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INSTALL AMLIB DIY (SELF-SERVICE) MODULE  

Please Note: This is only for libraries that have purchased this optional module. 

The Amlib DIY Module is installed in the same folder as the Amlib Client, so it is important that the 

latest version of the Amlib Client be installed BEFORE proceeding. 

IMPORTANT: Please ensure that you have full read/write access to the \Amlib folder on your DIY 

workstation (for example: C:\Amlib) and that you are logged in with Administrative Privileges. 

1. The Amlib DIY 5.3 Module installer is available on the OCLC Website, under Setup 

Programs>DIY:  
https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-3/setup-programs.en.html 

(contact Amlib support if you require a login to this website) 

2. Download the DIY53Setup.exe and save it on your DIY workstation 

3. Double-click the DIY53Setup.exe to launch the installation Wizard – the Setup – Amlib DIY 

Module screen will open displaying the Welcome message: 

 

4. Click the Next button – the Serial screen will display, prompting you for valid Serial Number: 

https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-3/setup-programs.en.html
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5. Enter the Serial Key supplied by OCLC (UK) Limited (case sensitive!) and then click the Next 

button – the Installation Location screen will display: 

 

6. Select the folder where the Amlib Client was installed in the previous section – a Default 

location will automatically display – for example: C:\Amlib 

7. Click the Next button – the Select Components window will display: 
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8. Choose which components should be installed: 

a. Modules To Install: 

 Amlib DIY Module (New Install - Complete) – installs the Amlib DIY program 

files into the existing Amlib Client folder 

9. Select options and click the Next button 

10. The Select Start Menu Folder screen will display: 

 

11. Enter a Start menu folder name (or leave as Amlib Library Management System)  and click 

the Next button – the Select Additional Tasks screen will display: 
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12. You can unselect the Install desktop icons for selected components if you DO NOT wish to 

install the Amlib DIY icon on the desktop 
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13. Click the Next button – the Ready to Install screen will display with a summary of the 

installation tasks to be performed: 

 

14. Click the Install button – the Installing window will display: 
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15. When complete click the Finish button 

 

16. The setup Wizard will close 

Installation of the Amlib DIY 5.3 Module is now complete. 
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SETTING AMLIB DIY PARAMETERS 

Location Codes 

To maintain statistics of DIY usage, it is necessary to create a unique location for each DIY service 

point. For example: a site intending to use the DIY Service at three (3) separate locations will need to 

create three (3) separate DIY Location Code entries in addition to the normal branch location codes.  

Please Note: If separate statistics are not required for DIY machines, it is not necessary to create a 

separate DIY location. Only create the DIY Username (see next section) and use an existing Location 

code. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > Locations – the Locations screen will display 

Enter a New DIY Location 

1. Click the F1 New or F2 Insert button 

2. Enter the follow details: 

a. Library Group Code 

b. Locn Code – for example: CHELSEADIY 

c. Location Description – for example: Chelsea DIY Module 

3. Click the F3 Save button when complete 
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Installation Settings (New DIY Locations Only) 

Any new DIY location/s will must be set up as circulating locations. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > Installation – the Installation DEFAULT screen will display 

3. From the menu, select Application > Choose Location – the Choose Location screen will 

display: 

 

4. Select the new DIY Location and click the OK button 

5. The Installation screen will display for the selected Location – for example: Chelsea DIY 

Module 

6. Select the Other tab 

7. Scroll down to the Location is valid for Registrations & Circulation option – place a Y in the 

corresponding Value field 

 

8. Click the F3 Save button when complete 

9. Repeat steps 3 – 8 for all new DIY Locations 
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Creating DIY Usernames 

To maintain circulation statistics through DIY, separate DIY User Names should be created for each 

DIY service point. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > UserNames – the User Names table will display 

Enter a New DIY User 

1. Click the F1 New or F2 Insert button – a new entry will appear in the table 

2. Type in the following: 

a. User Name = use one word only – for example: DIY or DIY1 

b. Location = the default login location of the DIY user – for example: CHELSEADIY 

c. Circ at this Location Only = N 

d. Level = 1 

 

3. Click the F3 Save button – the Operator Password screen will display: 

 

4. Type in a Password and Confirm Password 

5. Click the OK button when complete 

Please Note: DO NOT use the F8 Choose button to assign any User permissions. 
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Assign DIY User Names 

The DIY User Names must then be set up for use on the Opac User Names screen. A User Names 

must be assigned for each DIY service point. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > Opacs > OpacUserNames – the Opac User Names table will 

display 

Enter a New DIY User 

1. Click the F1 New or F2 Insert button – a new entry will appear in the table 

2. Type in the following: 

a. User Name = select a User from drop-down box – for example: DIY1 

b. Current Location Queries (Y/N) = N 

c. Web access via – leave blank 

 

3. Click the F3 Save button when complete 

4. Exit and restart the Amlib client for these settings to take effect 
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DIY Parameters 

The parameters for controlling the DIY (Self-Service) Module allow the definition of screen messages 

and validation overrides. Settings in this table can control the responses made by the devices that 

interface with the Amlib DIY Module. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > DIYParams – the Self Issue Parameters screen will display: 

 

HEADING DESCRIPTION EXAMPLE 

Type S Stock 

B Borrower 

Indicates whether the message refers to a Stockitem or 

Borrower process 

S 

Comment Program reference – for example: borr has memo Must not be altered 

Reference Program level reference number Must not be altered 

PROCEED Y/N Indicates whether the loan process is to proceed (Y) or it is 

terminated (N). Some settings  

Y 

System 

MESSAGE 

The message that the patron will see displayed when this 

process occurs 

Please call at the 

Information Desk 

Sound No The sound that will be heard when this process occurs. The 

Sound No is linked to the System Number found in Sounds 

table (Main > Supervisor > SoundTable) 

1 

  



Amlib DIY/SIP2 Installation Guide and User Manual 

 

 

 
Last Updated: 4 July 2013 

Version: 5.3 Page 28 

Type 

 

Comment Ref 

No 

Message Explanation – if N is 

selected in the Proceed column 

(except as stated) 

Sample System Message 

Borrower (B) 

B > max on loan 1 Type the message you wish your patrons 

to read if they have exceeded the loan 

limit 

You have exceeded the loan 

limits at this Library 

B borr has memo 2 Type the message you wish your patrons 

to read if they have a memo attached to 

their Borrower record 

Please call at the Service Desk 

– we have a message for you 

B borr has 

overdues 

3 Type the message you wish your patrons 

to read if they have overdue items on 

loan 

You have Overdue Items. 

Please call at the Service Desk. 

B borr owes money 4 Type the message you wish your patrons 

to read if they have overdue items on 

loan 

If Proceed = Y: 

Set parameter B30 to amount allowed 

You have an outstanding 

Account. Please call at the 

Service Desk. 

B Reregister on 

expiry 

5 Type a message to instruct the patron to 

re-register 

Please call at the Service Desk 

B borr has expired 6 Type the message you wish your patrons 

to read if their membership has expired. 

Please call at the Service Desk 

B Pin No Required 7 If Proceed = Y: 

Type a message instructing the patron to 

enter their PIN number. For SIP2 Check 

pin no. supplied. 

Please enter your PIN 

B Opac LogOff 8 KEYWORD used to exit the DIY module 

from the Main menu. 

EXIT      (the first 8 chars are 

used for AMLIB DIY) 

B OpacDelay 9 Type in a 3-digit figure to indicate the 

number of seconds for the DIY to return 

to Main menu. 

120 (first 3 characters are 

seconds to return to Main 

menu on AMLIB DIY) 

B Borrower groups 10 Borrower group(s) with preceding 

hyphen 

If Proceed = Y: 

List of permitted groups 

If Proceed = N: 

List of prohibited groups  

(Used to set  internet access for 

EnvisionWare) 

 

  



Amlib DIY/SIP2 Installation Guide and User Manual 

 

 

 
Last Updated: 4 July 2013 

Version: 5.3 Page 29 

B 3m Checkin 11 Instruct the 3M device to Allow/Disallow 

Returns 

 

B 3m Checkout 12 Instruct the 3M device to Allow/Disallow 

Issues 

 

B 3m Renewals 13 Instruct the 3M device to Allow/Disallow 

Renewals 

 

B 3m Update status 14 Instruct the 3M device to Allow/Disallow 

Borrower updates 

 

B 3m Offline 15 N/A  

B Amlib version 16 N/A  

B Institution Id 17 Library Service Name OCLC Library 

B Library Name 18 Library Name Chelsea Library 

B Terminal 

Location 

19 Library Location Code 2/899 Wellington Road, 

Rowville 3178 

B 3m Screen 

message 

20 Type the message you wish to display on 

the 3M device 

Storytime every Thursday at 

10.00am 

B 3m Print message 21 Type the message you wish to display on 

the 3M device. 

Renew your item online at 

www.amlib.com.au 

B 3m Status 

Proceed 

22 Type the message you wish to display on 

the 3M device. 

 

B Amlib Main 

Image 

23 Type in the path of the Main screen 

image 

C:\amlib\mm.bmp 

B Amlib Borr Image 24 Type in the path of the Patron card entry 

screen image 

C:\amlib\bm.bmp 

B Amlib Item Image 25 Type in the path of the item entry 

screen image 

C:\amlib\sm.bmp 

B Amlib Allow Print 26 If Proceed = Y: 

Will enable a Print button to print all 

items on loan. Use this message box to 

insert text within the Print button 

(Report template name: $SILOAN.QRP) 

Press here to Print 

B Wand Barcode 

Desc 

27 Type the message you want the patron 

to read to instruct them to enter their 

member number in the text box 

Enter your Library Card here 

B Print New Items 

List 

28 If Proceed = Y:  

Will enable a Print button to print only 

items issued in the session. Use this 

message box to insert text within the 

Print button 

(Report template name: $SILOAN.QRP) 

Print New Item only 
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B Borrower button 

text 

29 Type the message you want the patron 

to read if there is a status on their card 

that stops them from proceeding 

Press Enter to continue  

or for touch screen machines: 

Touch Here to Continue 

B Borrower fine 

limit 

30 The first 4 digits are limit in cents. Used 

in conjunction with parameter B4 

3100Your Account has 

exceeded the allowed limit 

B Allow Renewals 

in Amlib 

31 If Proceed = Y: 

Allow renewals in Amlib without item 

 

B Invalid borrower 

barcode 

32 Type the message you want the patron 

to read if there is a problem reading 

their card 

The bar code just entered has 

a problem. Try again or ask a 

Staff member for Help. 

B ADULT Borrower 

type(s) for 

internet access 

33 Borrower type(s) with preceding hyphen 

which are classed as ADULT 

(EnvisionWare only) 

 

B CHILD Borrower 

type(s) for 

internet access 

34 Borrower type(s) with preceding hyphen 

which are classed as CHILD 

(EnvisionWare only) 

 

Stockitem (S) 

S Item already on 

loan 

1 Type the message you wish your patrons 

to read if an item already on loan is 

being re-issued 

 

This item may not be issued. 

Please take it to the Service 

Desk. 

S Item has memo 2 Type the message you wish your patrons 

to read if the item has a memo attached 

This item may not be issued. 

Please take it to the Service 

Desk. 

S Item has alert 3 Type the message you wish your patrons 

to read if an alert is attached to the item 

This item may not be issued. 

Please take it to the Service 

Desk. 

S Item has alien 

reserve 

4 Type the message you wish your patrons 

to read if the item is reserved for 

another borrower 

This item may not be issued. 

Please take it to the Service 

Desk. 

S Cancel item 

charge 

5 Type the message you wish the patron 

to read if the issue charge is to be 

cancelled 

If Proceed = Y: 

Auto charge will be removed on check-in 

Item charge cancelled 

S Stop issue on 

charge 

6 Type the message you wish the patron 

to read if a charge is applicable for the 

issue 

This item may not be issued. 

Please take it to the Service 

Desk. 

S No loan 

parameter 

7 Type the message you want the patron 

to read if the item has no loan 

parameter. 

This item may not be issued. 

Please take it to the Service 

Desk. 
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S No renewal 

parameter 

8 Type the message you want the patron 

to read if the item has no renewal 

parameter. 

This item may not be 

renewed. Please take it to the 

Information Desk 

S Renewal limit 

exceeded 

9 Type the message you want the patron 

to read if the item exceeds the renewal 

limit. 

This item may not be 

renewed. Please take it to the 

Information Desk 

S Item not for loan 10 Type the message you want the patron 

to read if the item is not for loan. 

This item may not be issued. 

Please take it to the 

Information Desk 

S Renew overdue 

item 

11 Type the message you want the patron 

to read if the item to be renewed is 

already overdue. 

This item may not be 

renewed. Please take it to the 

Information Desk 

S Max items 

reached 

12 Type the message you want the patron 

to read if the item exceeds the patron 

loan limit. 

This item may not be issued. 

Please take it to the 

Information Desk 

S Exceeded form 

limit 

13 Type the message you want the patron 

to read if the item exceeds the patron 

loan limit for a Form Code. 

This item may not be issued. 

Please take it to the 

Information Desk 

S Magnetic Media 14 If Proceed = N: 

Will disallow the loan If you have 

Stockitem Form Codes that are not to be 

issued. These need to be defined here, 

separated with dash. 

For example: to prevent Videos (Form 

Code = VI) and Audio Cassettes (Form 

Code = AC), enter -VI-AC in this field 

along with a message to inform the 

patron 

-VI-AC These are sensitive 

items and cannot be lent via 

DIY 

S Magnetic Media 15 If Proceed = Y: 

Will allow the loan if you have Stockitem 

Form Codes that can be issued. These 

need to be defined here, separated with 

dash. 

For example: to allow CD’s (Form Code = 

CD) to be loaned enter -CD in this field 

along with a message to inform the 

patron 

-CD These are sensitive items 

and can be lent via DIY 

S Not to be 

removed 

16 If Proceed = N:  

Will prevent the loan. If you have 

Stockitem Form Codes that cannot be 

issued. These need to be defined here, 

separated with a dash.  

For example: to prevent Reference 

books (Form Code = RE) from being 

issued enter -RE in this field along with a 

message to inform the patron 

-RE These are Reference  items 

and cannot be lent via DIY 
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S Default loan 

period 

17 If using DIY offline you can define the 

loan period here.  

For example: if the loan period is 21 

days enter –21 in this field. 

-21 

S Item button text 18 If Proceed = N: 

Will trigger a dialogue box to appear 

after every issue. Use the message box 

type the message that will appear in the 

dialogue box. 

If Proceed = Y: 

Will not trigger a dialogue box 

Issue successful. Press Enter to 

Continue 

S Allow returns in 

Amlib 

19 If Proceed = Y: 

Will enable a returns function via a 

Returns button located on the DIY Main 

screen 

 

S Print return item 

list 

20 If Proceed = Y: 

Will enable a Print button to print 

returned items in the session. Use this 

message box to insert text within the 

Print button (Report template name: 

$SILOAN.QRP) 

Print Returns List 

S Return reserved 

item 

21 If Proceed = Y: 

Will alert user with message 

The returned item is on 

reserve to another borrower 

To alter a system message: 

1. Any of the System MESSAGEs can be changed to suit your Library service – for example: the 

message “Please call at the Information Desk” can be changed to something more 

meaningful 

2. Click the F3 Save button when complete – a prompt will appear with the following message: 

A new DIY.INI file has been created for use with DIY Systems. 

 

3. Click the OK button 

IMPORTANT: Editing the Self Issues Parameters table will generate a new DIY.ini configuration file. 

The updated DIY.ini configuration file MUST be copied to the Amlib Client folder (for example: 

C:\Amlib) on the Amlib DIY Self Service workstation. This file is only used when the Amlib DIY Module 

is used in offline mode – i.e.: not connected to the Amlib database. 
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Please Note: When using Amlib DIY Module in “Offline Mode” (i.e. not connecting to the Amlib 

database) the Issue and Return screens are not displayed. Instead, the Offline “select file” window 

and the Amlib offline capture screens are displayed. In this case the Location field and other 

parameters are read from the standard Amlib offline.ini file and DIY.ini configuration files so that 

some processing rules may be established. (The offline.ini file is the same file used in the Offline 

Circulation module).  

Setting Up Additional DIY Applications 

It is possible to run individual DIY applications using different parameters. This is especially useful at 

sites that incorporate the DIY with another vendor product (Talking Technologies, LogiTrack) as a 

backend and at the same time use DIY in the general circulation environment. Both applications may 

require some parameters to differ in order to perform effectively. Up to nine different sets of 

parameters can be created. 

1. Launch the Amlib client 

2. Go to Main > Supervisor > DIYParams – the Self Issue Parameters screen will display: 

 

3. Click the F1 New button – a prompt with the following message will display:  

Are you sure you really want to create a new set of DIY parameters 

Continue with creation? 

 

4. Click the Yes button – a prompt with the following message will display: A new DIY.INI file 

has been created for use with DIY Systems. 
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5. A new set of parameters have now been created – the Parameters for DIY will now read 2 of 

2: 

 

6. The parameters can be edited as required 
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TESTING LOGIN TO AMLIB 

The connection of the Amlib DIY Module can to the Amlib database can be tested as follows: 

1. On the DIY Workstation, select the DIY Self Issues icon from the Amlib program group in the 

Start menu (alternatively: double-click the DIY Self Issues icon on the desktop) 

2. The Amlib Self Service screen will display: 

 

3. Select the following options: 

a. Update Options:  

 OnLine to Database 

b. Transaction Types: 

 Issue Session 

c. Communications: 

 Serial 

d. Vendor: 

 D.I.Y. (Amlib No Security) 

4. Click the OK button 

This will log directly to Amlib without connecting to the 3M or Raeco Self Issue workstations. 
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5. The Database selection screen will display: 

 

6. Select the database you wish to connect to (for example: Live Database) and click the OK 

button 

7. The Self Issue Login screen will display: 

 

8. Type in a valid Opac User Name and Password (see Assign DIY User Names above) and click 

the OK button 

9. The Self Issue Terminal Confirmation screen will display: 

 

10. Select the DIY Location (for example: Chelsea DIY Module – DIY1) and click the OK button 
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11. If there is more than one DIY Parameter Set available (see Setting Up Additional DIY 

Applications above), the Parameter set screen will display: 

 

12. Select the appropriate Parameter set and click the OK button 

13. The DIY Self Issue screen will display: 

 

14. Click the F1 Start button to begin 

Please Note: The bitmap on the first DIY Self-Issues processing screen above can be customised for 

each library. 

 The password in DIY Self Issue Parameters option B8 (see DIY Parameters above) can be used 

on the Main menu to Exit the Amlib DIY Module.  
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AMLIB DIY AS A SELF-SERVICE APPLICATION 

Images 

There are three (3) images in the DIY module. The images can be bitmaps (.bmp) or .jpg and can be 

edited using picture-editing software – for example: Paint or Adobe Photoshop. 

 BM.bmp (or BM.jpg) 

 MM.bmp (or MM.jpg) 

 SM.bmp (or SM.jpg) 

The images to be used are set in the Self Issue Parameters screen in the Amlib client (see DIY 

Parameters above): 

 

1. Main Menu image: MM.bmp (Type: B23) 
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2. Borrower Details Image (requesting borrower barcode): BM.bmp (Type: B24) 

 

3. Stockitem Details Image (requesting stockitem barcode): SM.bmp (Type: B25) 

 

Template 

 On-loan print template for DIY 

The template $SILOAN.QRP may be customised to include the library name, address and telephone 

number. The $SILOAN.QRP template is used for All Issues, New issues and Print Returns function 

(Types: B26, B28, S20 in the Self Issues Parameters screen – see DIY Parameters above).  

The RepWin application can be used to customize the template. 
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Using DIY 

Self Issues 

 

Self Returns 

 

 The password set in the Self Issues Parameters screen (B8) can be used on the Main Menu 

screen to exit the Amlib DIY Module 
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AUTOMATING DIY LOGIN 

The login process for the Amlib DIY Module can be automated by configuring the default settings in 

the Amlib.ini configuration file located in the Windows folder (normally C:\Windows or C:\Winnt) 

SECTION / KEY DESCRIPTION 

[DIY]  Required Section Name in the Amlib.ini file   

Online=Y  Specifies that application will connect online to the Amlib database (default = Y) 

Issues=Y  Identifies whether Issue (Checkout) function is available (default = Y) 

Connection=IP  Specifies whether connection interface between Self Issues Kiosk and Amlib DIY Module 

is via TCP/IP or direct Serial connect (for example: RS-232) 

Choices are:  

 Connection=IP 

 Connection=SERIAL  

 (Default is SERIAL)  

Port=6001  IP Port No for connection interface (must be > 2000 and < 10000) Default is 6001.  

Always use a different port for each device. 

Vendor=3M  Type of device Amlib DIY Module is connecting to (default =3M).  Choices are:  

 Vendor=PI (Amlib Direct)   

 Vendor=AMLIB (Amlib with QLS security)  

 Vendor=3M   (this is the default option.  Also use for Overdrive) 

 Vendor=RAECO 

 Vendor=TALKINGTECH (iTiva from Talking Tech) 

 Vendor= STI (STi RFID)  

 Vendor= ENVISIONWARE 

 Vendor= SMARTLIBRARY (use for FE Technologies) 

AutoLogin=Y  Specifies whether Amlib DIY Module is to automatically login to the Amlib database 

(default = N)  

AutoConnect=Y  Specifies whether the Amlib DIY Module is to connect automatically to port specified 

and wait for a connection from the Self Issues device (default = N)  

Database=Live  Specifies which Amlib database to connect to.  Choices are: 

 Database=Live 

 Database=Test 

DefaultUser=  Amlib DIY Module login to use, together with optional encrypted password. The Amlib 

DIY Module login must be created within the Opac UserNames screen within the 

Supervisor module, and if you have multiple location/branches you will need to have a 

separate login for each location. Details on how to specify the password can be found 

later in this document. 

ParameterSet=2  Specifies which Amlib DIY Parameter Set to use from the Supervisor module (only 

required when more than DIY parameter set). 

Logging=Y  Specifies whether logging to diy.log will automatically occur on startup. 
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CONFIGURE AS A SIP/SIP2 GATEWAY TO LISTEN TO TCP/IP REQUESTS FROM 

MULTIPLE SOURCES  

Question: How do I set the Amlib DIY Module to listen for requests from multiple sources?  

(for example: from 3M Self Check Workstations, and from TalkingTech Telephone Renewals)  

Answer: The Amlib DIY Module needs to have PC (or server) configured to listen for TCP/IP requests 

(using SIP/SIP2 protocol) with a separate Amlib DIY Instance running for EACH source.   

• Example 1: Windows 2000/XP PC at Council server room with multiple Amlib DIY Module 

instances installed and configured, with each instance listening on a different TCP/IP Port for 

requests from 3rd party application   

• Example 2: Windows 2000/XP PC at Library Branch (for example: dedicated Reports PC, or 

Circulation Check-in PC) with multiple Amlib DIY Module instances installed and configured, 

with each instance listening on a different TCP/IP Port for requests from 3rd party application 

The advantage of example 2 above is that it will reduce network traffic within the Council/Library 

network, and improve response times to the Oracle database, as well as easy for the local library 

branch to restart the Amlib DIY module if required.  

Summary on how to configure Amlib DIY Instances on a single Server/PC:  

1. Ensure the C:\Windows\amlib.ini configuration file DOES NOT contain a section [DIY] or any 

parameters (since this will overwrite each individual Amlib DIY Module instance settings)  

2. Install the Amlib Client on the server/PC (for example: in C:\Amlib folder)  

3. Install the Amlib DIY Module on the server/PC (for example: in C:\Amlib folder)  

4. Configure the amlib.ini configuration file located in the client folder above (for example: 

C:\Amlib\amlib.ini) and add the section [DIY] with the required settings (see example 

below)  

5. Create a new folder C:\AmlibDIY2 for the 2nd Amlib DIY instance, and copy the diya.exe file 

(C:\Amlib\diya.exe) into the C:\AmlibDIY2 folder, and create a new amlib.ini file with the 

required DIY settings (see example below)  

6. For any additional instance repeat previous step (except name folder as C:\AmlibDIY3, etc.)  

See examples next page.  
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Example 1: Amlib DIY amlib.ini Settings (in C:\Amlib) to listen as Amlib/3M Gateway via Port 6001 

for 3M Self Check Requests for Bowen Library: 

[DIY] 

Online=Y 

Issues=Y  

Connection=IP 

Port=6001 

Vendor=3M 

AutoLogin=Y 

AutoConnect=Y 

Database=Live 

ParameterSet=1 

DefaultUser=BOWENSC 

DefaultPrefix=Live  

Example 2: Amlib DIY amlib.ini Settings (in C:\AmlibDIY2) to listen as Amlib/TalkTech Gateway via 

Port 6002 for TalkingTech LINE 1 Requests: 

[DIY] 

Online=Y 

Issues=Y 

Connection=IP 

Port=6002 

Vendor=TALKINGTECH 

AutoLogin=Y 

AutoConnect=Y 

Database=Live 

ParameterSet=2 

DefaultUser=TALK 

DefaultPrefix=Live  

Example 3: Amlib DIY amlib.ini Settings (in C:\AmlibDIY3) to listen as Amlib/TalkTech Gateway via 

Port 6003 for TalkingTech LINE 2 Requests: 

[DIY] 

Online=Y 

Issues=Y 

Connection=IP 

Port=6003 

Vendor=TALKINGTECH 

AutoLogin=Y 

AutoConnect=Y 

Database=Live 

ParameterSet=2 

DefaultUser=TALK 

DefaultPrefix=Live  

Please Note: In the above example a separate Amlib DIY instance is required for each TalkingTech 

Incoming Telephone Line. 
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SPECIFY PASSWORDS FOR AUTOLOGIN  

Question: How do I specify the password for the AutoLogin within the [DIY] section of the amlib.ini 

configuration file (especially if running multiple Amlib DIY Module Instances with each instance 

having a different username/password)?  

Answer: If you are only running one (1) instance of Amlib DIY Module on a PC and using the same DIY 

login and password, then the Amlib DIY Module will remember the password the next time you login 

via DIY. However, if you are running multiple instances of the Amlib DIY Module, each with its own 

login you will need to specify the each password if you wish to use the DIY AutoLogin feature.  

 Within the [ClientFolder]\amlib.ini (for example: C:\Amlib\amlib.ini) configuration file you 

can append the encrypted password to the DefaultUser= keyword. The format of the 

keyword is: 

o DefaultUser=Login,EncryptedPassword – for example: 

DefaultUser=PENNSC,tU+]Ln>sZ;'64p\<|0ry.>Rbk"[`Bh 

Question: How do I find out what the encrypted password is for each of my different DIY Logins?  

Answer: Use the following steps: 

1. Login to the Amlib DIY Module with required DIY Login and Password   

2. Open the [Windows]\amlib.ini configuration file (for example: C:\Windows\amlib.ini)  

3. Go to the section [DIY] and look for the keyword LastLive=  

4. Copy the encrypted password of the LastLive= keyword (will be the BOLD part of the 

following example: LastLive=PENNSC,tU+]Ln>sZ;'64p\<|0ry.>Rbk"[`Bh 

5. Open the required [ClientFolder]\amlib.ini (for example: C:\Amlib\amlib.ini) configuration 

file and append the password to the DefaultUser= keyword. The format of the keyword is 

DefaultUser=Login,EncryptedPassword – for example: 

DefaultUser=PENNSC,tU+]Ln>sZ;'64p\<|0ry.>Rbk"[`Bh 

Please ensure there is a comma (,)between the Login and Password 

Repeat the above steps for EACH DIY Login specified in each Amlib DIY Client Folder (C:\Amlibdiy2, 

C:\Amlibdiy3, etc.). 

IMPORTANT: You will need to repeat this process if you change your DIY passwords!  
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TROUBLESHOOTING TIPS  

The first step in troubleshooting problems that you may be experiencing with Amlib (Client or 

NetOpacs) connecting to the database is to first check the following:  

 Can you connect to the Amlib database using the Amlib Client on the server?  

 Can you connect to the Amlib database using the Amlib Client from another workstation?  

The next step is to try and isolate the problem and ensure that the problem is not due to the 

hardware, network or firewall. 

Check Communication to Database Server using Microsoft Port Query  

Microsoft Port Query is an easy to use tool that enables you to test whether you can connect from a 

Workstation (or Web Server) to the database server, and whether the RDBMS is listening for 

connection requests.  

1. Launch the Microsoft Port Query program, which will be located:  

 Amlib Client: C:\Amlib\Utility\PortQryUI\portqueryui.exe 

 NetOpacs: C:\Netopacs\Utility\PortQryUI\portqueryui.exe 

 ZServer: C:\Zserver\Utility\PortQryUI\portqueryui.exe  

Please Note: replace C:\Amlib or C:\Netopacs with the actual path where the applications 

have been installed 
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2. Enter the Destination IP address of the database server used when installing Amlib (for 

example: tardis, 127.0.0.1, etc.)  

3. Select the Manually input query ports option 

4. Enter the Ports to query: 

 If using Microsoft SQL Server, enter: 1433 

 If using Oracle, enter: 1521 (older versions of Oracle may be using: 1525) 

5. Protocol: TCP 

6. Then click the Query button to start the search 

Query Results 

1. If the Query result is LISTENING (for example: TCP port 1433 (ms-sql-s service): LISTENING) 

then this indicates: 

 the Workstation (or Web Server) can communicate to the database server OK  

 you will need to proceed to the next level of Amlib troubleshooting to identify the 

problem you are experiencing  

2. If the Query result is NOT LISTENING (for example: TCP port 1433 (ms-sql-s service): NOT 

LISTENING) then this indicates:  

 the Workstation (or Web Server) is unable to communicate to the RDBMS on the 

database server  

You should refer this problem to your organisation’s database or network 

administrator to follow up.  

 Possible reasons why it is unable to communicate to the RDBMS on the database 

server:  

i. the database server is not running  

ii. the database server is disconnected from the network  

iii. the workstation (or web server) is disconnected from the network  

iv. there is a problem with the network (for example: switch is faulty, DHCP is 

not running, etc.) or network configuration  

v. the RDBMS is not running on the database server (check in Windows Services 

whether the RDBMS (Microsoft SQL Server or Oracle) is running  

vi. the enterprise firewall is preventing connectivity via this Port  

vii. the workstation firewall (for example: Windows XP Service 2 firewall) is 

preventing connectivity via this Port  

viii. there a problem with hardware (for example: network card in either 

database server, workstation or web server)  
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3. If the Query result is FILTERED (for example: TCP port 1433 (ms-sql-s service): FILTERED) 

then this indicates:  

 the enterprise firewall is preventing connectivity via this Port  

 the workstation firewall (for example: Windows XP Service 2 firewall) is preventing 

connectivity via this Port 

You should refer this problem to your organisation’s database or network administrator 

to follow up.  

Next Level of Amlib Troubleshooting 

 Message: Cannot connect to Amlib database. 

A message “Cannot connect to remote Amlib database” is displayed  if the PC is unable to connect via 

the WAN (or if sql.ini is not correctly configured): 

 

The following steps can be used to track down the problem:  

1. Review the RDBMS error message displayed on the Cannot connect screen – for example: 

the above example refers to Error No. 20016…SQL Server does not exist… This is a SQL 

Server error and should be following up with your database administrator (the error number 

is not an Amlib error number) 

2. Can the PC connect to the database server? – refer to the previous section Check 

Communication to Database Server using Microsoft Port Query above 

3. If step 2 above is OK, then ensure that you DO NOT have any ODBC Data Sources with the 

same name as the database (for example: make sure there is NOT an ODBC data source 

called AMCAT, AMLIB, AMLOCAL, AMSTATS or AMWEB) 

 In Windows XP, go to: Control Panel > Administrative Tools > Data Sources (ODBC), 

and check within the User DSN, System DSN or File DSN tabs 

 In Windows Vista/7, go to: Control Panel > System and Security > Administrative 

Tools > Data Sources (ODBC), and check within the User DSN, System DSN or File 

DSN tabs 
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4. If step 3 above is OK, then identify whether the SQL.ini is correctly configured or whether 

there is a connection error – to test: 

 Launch the Amlib Upgrade (\Amlib\upgrade.exe) SQL interface application 

 From the menu, select File > Advanced Login – the Advanced Login screen will 

display: 

 

 Enter the login details: 

  Login name: SYSADM 

 Password: SYSADM 

 Database: AMCAT 

 Click the OK button 

 If Upgrade is able to connect OK to the selected database and will return to 

the main Upgrade screen and display the username and database 
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 For SQL Server RDBMS: repeat the above Advanced Login step for each other 

database (AMLIB, AMLOCAL, AMSTATS and AMWEB) to see whether the 

problem is due to being unable to connect to only 1 of the databases 

If Upgrade is unable to connect to the selected database then take a detailed copy of 

the displayed error message (for example: press [Prt Scn] on your keyboard and 

Paste into a MS Word document) and contact Amlib Support for further assistance: 

 
 

It is also suggested that you take a note of the Error number and research with 

the RDBMS vendor the explanation and resolution for the Error number:  

 For Microsoft SQL Server 2008 R2: http://support.microsoft.com 

 For Oracle: http://www.oracle.com/support/index.html 

Some of the reasons that the Upgrade.exe is unable to connect to the selected 

database:  

 The database does not exist within the RDBMS (for example: if an 

administrator had deleted the AMCAT database)  

 The administrator had moved the Amlib databases to another server  

 The database server has insufficient disk space  

 The Amlib SQL.ini configuration file (located in the C:\Amlib folder for the 

Amlib Client, or C:\Netopacs for the NetOpacs module) is not correctly 

configured – for more information on this refer to the separate document 

relating to SQL.ini Client Communication and Configuration File 

 For libraries using Oracle RDBMS – the Oracle 10 Client is not correctly 

configured (using the Oracle TNSPING utility on the Workstation to test)  

 For libraries using Microsoft SQL Server – an old version of the Windows 

MDAC (ODBC) drivers are installed 

5. If step 4 above is OK, then perhaps the Amlib database connection settings held in 

\[windows]\amlib.ini are incorrect (these are different to the DIY Default User and Login 

settings) 

 For more information on Amlib database connection settings refer to Appendix A: 

Amlib Database Connection Settings 

  

http://support.microsoft.com/
http://www.oracle.com/support/index.html
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Advanced Support Note for Oracle Version 10 Client 

Unable to Retrieve Rows from the database Amlib support has identified some problems that some 

workstations and web servers using Oracle 10 Client and Amlib:  

 The PCs would “hang” when trying to login to Amlib and display a message that it is unable to 

connect to the database  

 When trying to using SQLTalk to troubleshoot, you can connect to the database but SQLTalk 

would hang when trying to retrieve rows from any tables (for example: select * from 

borrower) 

Action Taken: 

 In the Windows registry (regedit) within HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 

create a new String value of ORAOCI with a value of ORACLIENT8.DLL  

 If problem still occurs rename or remove the file C:\Amlib\OCIW32.DLL especially since this 

file will already exist in the Oracle Client installation folder. 

• Technical Notes from Centura Using OCIW32.DLL: In CTD 1.1.1, the Oracle router utilizes an 

Oracle DLL named OCIW32.DLL. As the Oracle documentation describes the function of this 

library, it uses the 'variable' ORAOCI to determine the name of the Oracle client DLL to load. If 

ORAOCI is not defined, OCIW32 will search through a predefined list of known Oracle client 

DLL names (most recent to least recent releases) until it either finds one or exhausts the 

known names and returns an error. The version of OCIW32.DLL that ships with CTD has a 

predefined list of Oracle client DLL names which predates the release of Oracle 8. If a 

particular workstation has only Oracle 8 files installed, the Oracle client DLL will not be found; 

this will have a name like ORA803.DLL. To correct this problem, either delete or rename the 

OCIW32.DLL that comes with CTD so that the Oracle router will load the OCIW32.DLL 

released by Oracle which knows about the Oracle 8 client DLL names, or define the variable 

ORAOCI to point to ORA803.DLL (or whatever name is current). This variable is located in the 

registry, and the CTD release notes contain instructions on how to locate it and set its value.  
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Testing Whether Amlib DIY Listening for SIP2 Requests  

To test whether Amlib DIY Self Issues is listening for SIP2 Requests (assuming you have setup DIY as 

a Middleware “Gateway” listening for SIP2 requests). 

1. Launch the Microsoft Port Query program, which will be located:  

 Amlib Client: C:\Amlib\Utility\PortQryUI\portqueryui.exe 

 Please Note: replace C:\Amlib with the actual path where the application has been installed 

 

2. Enter the Destination IP address of the Amlib DIY workstation/server configured to listen for 

SIP2 requests (for example: tardis, 127.0.0.1, localhost, etc.)  

3. Select the Manually input query ports option 

4. Enter the TCP Port  

5. Enter the TCP Port you have configured Amlib DIY to listen for SIP2 Requests in Ports to 

query :   

 such as 6000 or 6002 (you can also enter a range of port numbers  

if required) 

6. Protocol: TCP 

7. Then click the Query button to start the search 
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Query Results 

1. If the Query result is LISTENING (for example: TCP port 6000 (unknown service): LISTENING) 

then this indicates:  

 the Workstation (or Web Server) IS listening for SIP2 requests on the select port  

2. If the Query result is NOT LISTENING (for example: TCP port 6001 (unknown service): NOT 

LISTENING) then this indicates:  

 the Workstation (or Web Server) is NOT listening for SIP2 requests on the select port  

You should refer this problem to your organisation’s database or network administrator to 

follow up.  

Possible reasons why it is unable to listen for SIP2 requests:  

 the Amlib DIY Module is not correctly configured  

 the correct amlib.ini Configuration File entries have not been made OR there is a 

conflict between the C:\Amlib\amlib.ini and C:\Windows\amlib.ini  

 the workstation (or server) is not running or is disconnected from the network  

 there is a problem with the network (for example: switch is faulty, DHCP is not 

running, etc.) or network configuration  

 the enterprise firewall is preventing connectivity via this Port  

 the workstation firewall (for example: Windows XP Service 2 firewall) is preventing 

connectivity via this Port  

3. If the Query result is FILTERED (for example: TCP port 6001 (unknown service): FILTERED) 

then this indicates:  

 the enterprise firewall is preventing connectivity via this Port  

 the workstation/server firewall (for example: Windows XP Service 2 firewall) is 

preventing connectivity via this Port  

You should refer this problem to your organisation’s database or network administrator to 

follow up.  

Amlib DIY with Raeco Fast Track  

Raeco Fast Track self-issue systems use a Visual Basic interface file called MSCOMM.VBX to 

communicate to library systems such as Amlib. This file should be located in the C:\Windows 

(Windows 95/98/Vista/7) or C:\Winnt (Windows NT/2000) folders. If the Amlib DIY Module is unable 

to connect to Raeco Fast Track then you should copy mscomm.vbx from your Amlib Client software 

folder (for example: C:\Amlib) to your Windows folder.  
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SIP2 Protocol Troubleshooting 

To troubleshoot problems with vendor devices which use the SIP/SIP2 protocol a LogFile checkbox is 

available on the connection window. All SIP/SIP2 packets sent and received by DIY are written to a 

log file named diy.log in the folder where diya.exe was loaded from. Logging can also be enabled on 

start up using the Logging setting in the amlib.ini. This is useful when DIY is running as a service – for 

example: using FireDaemon 
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APPENDICES 

Appendix A: Amlib Database Connection Settings  

As from version 5.1 Amlib Client/Server (and AmlibNet) will both use a single login on the RDBMS. In 

previous versions, each Amlib user had his or her own Login.  

This has a number of advantages: 

1. Ordinary users will not have knowledge of a database login that can be used outside Amlib 

2. Amlib operator details can be added or altered without the need for an extra database login  

3. The RDBMS will not become cluttered with logins, some of which may be obsolete  

4. SQL Server’s new more restrictive login security requirements will not be a problem  

5. Changing the logged in user in Amlib is now almost instantaneous 

Configuration File  

The amlib.ini file must now contain keys that specify the login name and password used by Amlib. 

These can be encrypted if required. The nopasswd.exe can be used to encrypt logins and passwords.  

Sample Amlib configuration file settings using encryption: 

[Special] 

DatabaseUser=AMNET  

DatabasePw=Y8X:4/Mpzaa50/%TTEnga{uuMU2UxUf9Z|*jia-(Sr-QE}gs2f@_V91^6pSJ9'uzae[<a  

Sample AmlibNet configuration file settings, not encrypted: 

DatabaseUser=AMNET  

DatabasePw=AMNET 

Location of amlib.ini configuration file:  

 Amlib Windows Client: [Windows]folder (for example: C:\Windows for Windows XP)  

 Amlib DIY Module:  [Windows]folder (for example: C:\Windows for Windows XP) 

 Amlib NetOpacs: [Netopacs] folder (for example: C:\Netopacs)  

 AmlibNet: AmlibNet application folder (for example: C:\Amlib\Amlibnet\bornet)  

Passwords 

User passwords will be stored in Amlib. The conversion script creates a password for each Amlib user 

that is the same as the User’s name – for example: A user called STAFF will have a password of 

STAFF. The password can be changed in Supervisor module (Main > Supervisor > UserNames).  

Logins 
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The RDBMS login used by the application should have the db_owner role in each database in SQL 

Server and the appropriate rights on other platforms. If the login has the same settings as SYSADM it 

will work correctly.  

Logins cannot be created from within Amlib. They must be created using the tools provided with the 

RDBMS. Scripts are available for the creation of a suitable login on SQL Server 2005.  

Appendix B: Relationship between DIY Parameters and SIP2 Protocol 

The Supervisor DIY Self Issue Parameters (see DIY Parameters above) are used to control the 

operation of the external devices communicating with the Amlib DIY Module using the 3M SIP2 

protocol and the direct user interface mode. 

The response packet numbers and their fields controlled by parameters for the SIP 2 mode are 

defined below: 

 1 = Amlib DIY used as a Self-Service Application only 

 2 = EnvisionWare  

 3 = 3M 

Type 

 

Comment Reference 

No 

PROCEED 

Y/N 

System Message 3M SIP2 Protocol 

Response 

message/field 

Borrower (B) 

B > max on loan 1 N You have exceeded the 

loan limits at this Library 

If Proceed = N: 

12 – ok = 0 and screen 

message = user 

message 

B Borrower has 

memo 

2 N Please call at the Service 

Desk as we have a 

message for you 

If Proceed = N: 

64 - BL = N 

 Summary Position  4 = 

Y and screen message = 

user message 

B Borrower has 

overdues 

3 Y You have overdue items 

on Loan. Please call at 

the Service Desk 

If Proceed = N: 

64 - BL = N 

Summary Position  0,1 

= YY and screen 

message = user 

message 

B Borrower owes 

money 

4 Y You have an outstanding 

account. Please call at 

the Service Desk 

If Proceed = Y: 

Check parameter B30 if 

amount  owing is not 

zero 
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Else: 

64 - BL = N 

Summary Position  0,1 

= YY and screen 

message = user 

message 

B Borrower 

reregister on 

expiry 

5 N None N/A 

B Borrower has 

expired 

6 N Your registration has 

expired. Please call at the 

Service Desk 

If Proceed = N: 

64 - BL = N  

Summary Position:  0,1 

= YY and screen 

message = user 

message 

B Borrower PIN No 

Required if 

Proceed = Y 

7 N Please enter your PIN 

number  

If PIN Valid: 

64 – CQ = Y 

Else: 

64 – CQ = N 

Summary Position  0,1 

= YY 

B Log off password 8 Y EXIT       the first 8 chars 

are used for AMLIB DIY 

1
N/A 

B Inactivity timeout 9 Y 120              the first 3 

characters are seconds to 

return to Main Menu on 

Amlib DIY Module 

1
N/A 

B Borrower 

group(s) with 

preceding hyphen 

If Proceed =Y: 

List of permitted 

groups 

If Proceed =N: 

List of prohibited 

groups  

** Used to set  

internet access 

for EnvisionWare 

10 N  64 - BL = N 

2
64 – field PA is set to I 

(internet allowed) or 

NI (no internet 

allowed) 
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B 3m Checkin  11 Y Allow / Disallow returns 

from Device 

98 – Checkin ok 

B 3m Checkout 12 N Allow / Disallow issues 

from Device 

98 – Checkout ok 

B 3m Renewals 13 Y Allow / Disallow renewals 

from Device 

98 – ACS renewal 

policy 

B 3m Update status 

Process  01 Block 

Patron request 

14 N Update borrower status 

if instructed by device 

98 – status update ok 

 

B 3m Offline 15 N N/A  N/A for SIP2 

B  Amlib version 16 Y N/A N/A for SIP2 

B  Institution Id 17 Y Amlib Public Library 98 – AO institution id 

B Library Name 18 Y Inverness Rd Branch N/A( if online) 

B Terminal Location 19 N INV N/A (if online) 

B 3m Screen 

message 

20 Y Welcome to the Library 98 – AF  screen 

message 

B 3m Print message 21 Y Happy Christmas 98 – AG  print line 

B 3m Status 

Proceed 

22 Y ok 98 – on-line status 

B Amlib Main Image 23 Y <Path to image file> 
1
N/A for SIP2 

B Amlib Borr Image 24 Y <Path to image file> 
1
N/A for SIP2 

B Amlib Item Image 25 Y <Path to image file> 
1
N/A for SIP2 

B Amlib Allow Print 

onloan  

26 Y Print All Items 
1
N/A for SIP2 

B Wand Barcode 

Desc 

27 Y Your Card Number 

should appear here 

1
N/A for SIP2 

B Amlib Allow Print 

new items 

28 Y Print New Items 
1
N/A for SIP2 

B Borrower button 

text 

29 N Please Press the Enter 

Key to Continue 

1
N/A for SIP2 

B Borrower fine 

limit – the 1
st

 4 

digits are limit in 

cents 

30 N 3100Your Account has 

exceeded the allowed 

limit 

If Proceed = N: and 

amt owing is > value in 

message: 

64 - BL = N  

Summary Position  0,1 

= YY and screen 

message = user 

message - 1
st

 4 digits 
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B Allow renewals in 

Amlib 

31 Y Allow renewals in Amlib 

without item 

1
N/A for SIP2 

B Amlib Invalid 

borrower barcode 

32 N The bar code just entered 

has a problem. Try again 

or ask a Staff member for 

Help 

1
N/A for SIP2 

B Borrower type(s) 

with preceding 

hyphen which are 

classed as ADULT 

33 Y  
2
64 – field ZY is set to 

ADULT 

B Borrower type(s) 

with preceding 

hyphen which are 

classed as CHILD 

34 Y  
2
64 – field ZY is set to 

CHILD 

3
64 - BL = N if borrower 

type in list 

Stockitem (S) 

Type Comment Reference 

No 

PROCEED 

Y/N 

System Message 3M SIP2 Protocol 

S Item already on 

loan 

1 Y This item may not be 

issued. Please take it to 

the Service Desk 

If Proceed = N: 

12 – ok = 0 and screen 

message = user 

message 

S item has memo  2 N This item may not be 

issued. Please take it to 

the Service Desk 

If Proceed = N: 

12 – ok = 0 and screen 

message = user 

message 

S item has alert 3 N This item may not be 

issued. Please take it to 

the Service Desk 

If Proceed = N: 

12 – ok = 0 and screen 

message = user 

message 

S item has alien 

reserve 

4 N This item may not be 

issued. Please take it to 

the Service Desk 

If Proceed = N: 

12 – ok = 0 and screen 

message = user 

message 

S If Proceed = Y: 

Check for item 

charge on return 

and  cancel 

5 Y Item charge cancelled  
1
N/A for SIP2 

S stop issue on 

charge 

6 N This item may not be 

issued. Please take it to 

the Service Desk 
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S No loan allowed 7 N You may not borrow this 

type of Item 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S No  renewal 

allowed 

8 N You may not renew this 

type of item 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S Renewal limit 

exceeded 

9 N You have renewed this 

too often already 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S Item not for 

loan 

10 N This item may not be 

borrowed 

If Proceed = N: 

12 – ok = 0 

S Renew Overdue 

Item 

11 Y Item is overdue and may 

not be renewed 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S Max Items 

Reached 

12 N You have too many 

items on loan already 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S Exceeded Form 

Limit 

13 N You have too many 

items of that type on 

loan 

If Proceed = N: 

12 – ok = 0 and screen 

message = user message 

S Magnetic media 

- Item form 

code(s) with 

preceding 

hyphen 

If Proceed = Y: 

List of permitted 

form codes 

If Proceed = N: 

List of prohibited 

form codes 

14 N  If form in list and 

Proceed = Y: 

12 – magnetic media = N 

Desensitize = N 

Else: 

12 – magnetic media = Y 

Desensitize = N 

 

S Magnetic media 

- Item form 

code(s) with 

preceding 

hyphen 

If Proceed =Y: 

List of permitted 

form codes 

If Proceed =N: 

List of prohibited 

form codes 

15 Y  If form in list and 

Proceed = N: 

12 – magnetic media = Y 

Desensitize = N 
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S Items not to be 

removed from 

library – for 

example: 

Reference 

Item form 

code(s) with 

preceding 

hyphen  

16 N  If form in list: 

12 –Desensitize = N 

 

S Default loan 

period 

17 Y -21  When offline allow 

this to be used as a 

default loan for display 

purposes 

1
N/A for SIP2 

S Amlib - Item 

button text 

18 N Process the next Item or 

Press Esc to Finish 

1
N/A for SIP2 

S  Allow returns in 

Amlib 

19 Y Allow returns in Amlib 
1
N/A for SIP2 

S  Amlib - Print 

return items list 

20 Y Print 
1
N/A for SIP2 

S Return reserved 

item 

21 N The returned item is on 

reserve to another 

borrower 

If Proceed = Y and item 

reserved: 

10 – alert = Y and screen 

message = user message 
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Appendix C: SIP/SIP2 Packets Supported by Vendor Type 

3M Self Check 

SIP SIP2 

 97 – Request ACS Resend 

 99 – SC Status 

 23 – Patron Status Request 

 01 – Block Patron 

 11 – Checkout 

 109 – Checkin 

 263 – Patron Information 

 35 – End Patron Session 

 17 – Item Information 

 29 – Renew 

 65 – Renew All 

 37 – Fee Paid 

1SIP2 Extensions are used in the response packet: 

 CV field – Alert type 

The following alerts are checked for: 

VALUE STATUS 

 01 

 02 

 03 

 hold for this library 

 hold for other branch 

 send to other branch 

 CT field – Destination Location 

 CY Field – Hold Patron ID 

 DA Field – Hold Patron Name 

2Special processing is used in the response packet: 

 Check Borrower Type against the list in parameter B34. If found set the Valid Patron flag to N 

and screen message to 'Not a permitted Borrower Type' 
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TalkingTech iTiva 

SIP SIP2 

 97 – Request ACS Resend 

 99 – SC Status 

 01 – Block Patron 

 

 63 – Patron Information 

 35 – End Patron Session 

 17 – Item Information 

 29 – Renew 

 65 – Renew All 

 15 – Hold 

STi LogiTrack RFID 

**No packet checksum is generated for this device. 

SIP SIP2 

 97 – Request ACS Resend 

 99 – SC Status 

 23 – Patron Status Request 

 11 – Checkout 

 09 – Checkin 

 63 – Patron Information 

 

EnvisionWare 

 SIP SIP2 

 97 – Request ACS Resend 

 99 – SC Status 

 23 – Patron Status Request 

 01 – Block Patron 

 11 – Checkout 

 209 – Checkin 

 163 – Patron Information 

 35 – End Patron Session 

 17 – Item Information 

 29 – Renew 

 65 – Renew All 

 37 – Fee Paid 

1Special fields or formatting are used in the response packet: 

Non standard fields: 

 ZY field – Using Borrower type (either ADULT or CHILD or no ZY field) 

 PA field - Internet access using Borrower group (I = Internet OK / NI = No Internet) 
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Non standard format in fields: 

 AT field – Overdue items: 

o Item Barcode <space>Item due date<space>Issuing location<space>$0.00<space>Item 

title 

 AV field – Fine/Fees: 

o Transaction id <space>$Fine amount<space> Fine type<space> Item title/comments 

 AS field – Available Hold items: 

o Item Barcode <space>Reserve location<space>Reserve 

Date<space>$0.00<space>b<space>Item title 

 CD field – Unavailable Hold items: 

o Item Barcode <space>Reserve location<space>Reserve 

Date<space>$0.00<space>b<space>Item title 

2SIP2 Extensions are used in the response packet: 

 CV Field – Alert type 

The following alerts are checked for: 

VALUE STATUS 

 01 

 02 

 04 

 hold for this library 

 hold for other branch 

 send to other branch 

 CT field – Destination Location 

 CY Field – Hold Patron ID 

 DA Field – Hold Patron Name 
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SmartLibrary 

SIP SIP2 

 97 – Request ACS Resend 

 99 – SC Status 

 23 – Patron Status Request 

 01 – Block Patron 

 11 – Checkout 

 209 – Checkin 

 63 – Patron Information 

 35 – End Patron Session 

 117 – Item Information 

 29 – Renew 

 65 – Renew All 

1Special fields or formatting are used in the response packet: 

Non standard fields: 

 CR field – Item collection code 

 CS field – Item Call Number 

The fields are separated by a ^ character 

2SIP2 Extensions are used in the response packet: 

 CR field – Item collection code 

 CS field – Item Call Number 

 CT field – Destination Location 

 CV Field – Alert type 

The following alerts are checked for: 

VALUE STATUS 

 02 

 02 

 hold for this library 

 hold for other branch 

 CY Field – Hold Patron ID 

 DA Field – Hold Patron Name 

 


